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Supplementary Table S1. Analyses conducted on samples in the Bcc trial (13 patients, 80 

155 samples) 81 

 82 

Patient 

Visit number (paired samples) 

V1 V2 V4 V5 V7 V8 

1 2 1 2 1 2 1 2 1 2 1 2 

27610-001 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-002 ABCD A ABC A ABC A ABC A ABC - ABC A 

27610-003 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-004 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-005 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-006 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-007 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-008 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-009 ABCD A ABC A ABC A ABC A ABC A ABC A 

27610-011 ABCD A ABC A ABC A ABC A AB AC ABC A 

27611-002 ABCD A ABC A ABC A ABC A ABC A ABC A 

27611-005 ABCD A ABC A ABC A ABC A ABC A ABC A 

27611-006 ABCD A ABC A ABC A ABC A ABC A ABC A 

 83 
Footnotes: A, sample subjected to 16s rRNA gene sequencing and used in paired analysis to determine 84 
microbiota concordance; B, sample used in qPCR analysis; C, 16S rRNA sequencing results used to 85 

examine genus relative abundance, alpha and beta diversity metrics and for identification of trends in 86 
the dataset; D, sample used to determine the identity of the infecting Burkholderia species by recA and 87 
gyrB gene amplification, sequencing and analysis; ‘-’ sample not received and not analysed. 88 



Supplementary Table S2. Analyses conducted on samples in the P. aeruginosa trial (45 89 

patients, 511 samples) 90 

Patient 

Visit number (paired samples) 

V1 V2 V4 V5 V7 V8 

1 2 1 2 1 2 1 2 1 2 1 2 

27601-001 ABC A ABC A ABC A ABC A ABC A ABC A 

27601-002 ABC - ABC A ABC A ABC - ABC A ABC - 

27601-004 ABC A ABC - ABC A ABC A ABC - ABC A 

27602-001 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-002 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-003 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-006 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-007 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-008 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-009 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-010 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-011 ABC A ABC A ABC A ABC A ABC A ABC A 

27602-013 ABC A ABC A ABC A ABC A ABC A ABC A 

27603-001 ABC A ABC A ABC A ABC A ABC A ABC A 

27604-002 ABC A ABC A ABC A ABC A ABC A ABC A 

27604-003 ABC A ABC A ABC A ABC A ABC A ABC A 

27605-001 ABC A ABC A ABC - ABC A ABC A ABC - 

27605-002 ABC - ABC A ABC A ABC A ABC - ABC A 

27606-002 ABC A ABC A ABC A ABC A ABC A ABC A 

27606-003 ABC A ABC A ABC A ABC A ABC A ABC A 

27606-004 ABC A ABC A ABC A ABC A ABC A ABC A 

27606-005 ABC A ABC A ABC A ABC A ABC A ABC A 

27607-001 ABC A ABC A ABC - ABC A ABC A ABC A 

27607-002 ABC A ABC A ABC A ABC A ABC A ABC A 

27607-003 ABC A ABC A ABC A ABC A ABC A ABC A 

75201-001 ABC A ABC A ABC A ABC A ABC A ABC A 

75201-004 ABC A ABC A ABC A ABC A ABC A ABC A 

75202-001 ABC - ABC - ABC - ABC - ABC - ABC - 

75202-002 ABC - ABC - ABC - ABC - ABC - ABC - 

75202-003 ABC - ABC - ABC - ABC - ABC - ABC - 

82601-003 ABC - ABC A ABC A ABC A ABC A ABC A 

82602-002 ABC A ABC A ABC A ABC A ABC A ABC A 

82602-005 ABC A ABC A ABC A ABC A ABC A ABC A 

82602-006 ABC A ABC A ABC A ABC A ABC A ABC A 

82602-009 ABC A ABC A ABC A ABC A ABC A ABC A 

82602-010 ABC A ABC A ABC A ABC A ABC A ABC A 

82603-001 AB AC ABC A ABC A ABC A ABC A ABC A 

82603-004 ABC A ABC A ABC A ABC A ABC A ABC A 

82604-004 ABC A ABC A ABC A ABC A ABC A ABC A 

82604-006 ABC A ABC A ABC A ABC A ABC A ABC A 



82604-008 ABC A ABC A ABC A ABC A ABC A ABC A 

82604-009 ABC A ABC A ABC A ABC A ABC A ABC A 

82606-001 ABC A ABC A ABC A ABC A ABC A ABC A 

82608-002 ABC A ABC A ABC A ABC A ABC A ABC A 

57801-002 ABC A ABC A ABC A ABC A ABC A ABC A 

Footnotes: A, sample subjected to 16s rRNA gene sequencing and used in paired analysis to 91 
determine microbiota concordance; B, sample used in qPCR analysis; C, 16S rRNA gene sequencing 92 
results used to examine genus relative abundance, alpha and beta diversity metrics and for 93 
identification of trends in the dataset; ‘-’ sample not received and not analysed.  94 



Supplementary Table S3. Statistical analysis of Shannon diversity at three paired start-end 95 

points for the Bcc and P. aeruginosa trials (Wilcoxon signed-rank test) 96 

Treatment Test statistic P-value 

Bcc trial 

Start-End V = 31 P = 0.3396 

OligoG Start-End V = 38 P = 0.6355 

Placebo Start-End V = 42 P = 0. 8394 
P. aeruginosa trial 

Start-End V = 410.5 P = 0.2293 

OligoG Start-End V = 541 P = 0.7971 

Placebo Start-End V = 498 P = 0.8318 

 97 

 98 

 99 

Supplementary Table S4. Statistical analysis of the total abundance (qPCR) of key 100 

pathogens at three paired start-end points for the Bcc and P. aeruginosa trials (Wilcoxon 101 

signed-rank test) 102 

Treatment Test statistic P-value 

Bcc trial – Burkholderia total abundance 

Start-End V = 18 P = 0.05737 

OligoG Start-End V = 51 P = 0.7354 

Placebo Start-End V = 78 P = 0.02148 
P. aeruginosa trial – P. aeruginosa total abundance 

Start-End V = 470.5 P = 0.8171 

OligoG Start-End V = 456.5 P = 0.7411 

Placebo Start-End V = 401 P = 0.7071 
 103 

Footnotes: Statistically significant differences are highlighted in green. 104 

 105 

 106 

 107 

Supplementary Table S5. Statistical analysis of the relative abundance of key pathogens at 108 

three paired start-end points for the Bcc and P. aeruginosa trials using GAMLSS-BEINF and 109 

(mu) logit links 110 

Treatment Estimate Std. Error t value Pr (>|t|) 

Bcc trial – Burkholderia relative abundance 

Start-End 0.5107 0.4409 1.158 0.267 

OligoG Start-End 0.6461 0.2944 2.195 0.05589 

Placebo Start-End 0.5859 0.3010 1.947 0.083261 
P. aeruginosa trial – P. aeruginosa relative abundance 

Start-End -0.5372 0.1656 -3.244 0.00226 

OligoG Start-End -0.1030 0.1729 -0.595 0.555 

Placebo Start-End 0.2714 0.1757 1.545 0.129 

 111 

Footnotes: The estimates from the GAMLESS-BEINF models are the difference in log odds of relative abundances 112 
between groups. In each model, treatment was the response variable and patient ID was the random effect, with 113 
treatment ‘start’ as the reference class to which treatment ‘end’ was compared. Statistically significant differences 114 
are highlighted in green. 115 



Supplementary Table S6. The relative and total abundance of Burkholderia  116 

 in Bcc trial samples 117 

 118 

Patient 
Burkholderia 
species 

Relative abundance 
(%) 

Total abundance (Log 
Bcc/g sputum) 

27610-002 

B. cenocepacia 

90.29 7.74 

27610-005 99.62 8.55 

27610-006 62.54 8.01 

27611-002 66.52 7.36 

27610-001 

B. multivorans 

5.2 5.96 

27610-004 98.98 8.33 

27610-007 8.41 7.50 

27610-008 93.56 8.30 

27610-009 79.65 6.96 

27611-006 2.10 6.41 

27610-003 

Unknown 

0.07 0.76 

27610-011 0.00 5.44 

27611-005 0.09 3.69 

 119 

  120 



 121 

 122 

 123 

 124 

Supplementary Figure S1. Paired samples from the Bcc and P. aeruginosa trials were 125 

concordant as shown by high Pearson product-moment correlation coefficient 126 

(PPMCC) values. The boxplots show the spread of the PPMCC values for each trial, with the 127 

mean value highlighted by a cross in the centre of the plots. The number of samples in each 128 

trial and the mean values are shown above the plots. 129 

 130 



 131 
 132 

Supplementary Figure S2. The lung microbiota in the P. aeruginosa trial was linked to 133 

the individual rather than treatment. NMDS analysis of Bray-Curtis dissimilarity values for 134 

S1 samples from all 6 time points for the 45 patients on the P. aeruginosa trial (except 135 

82601003 that only had S2 for V1) are shown and grouped by treatment (A) and patient (B). 136 

Points represent individual samples, ellipses are standard deviations of points scores for each 137 

grouping. The top 10% genera based on abundance across the whole dataset are shown in 138 

(A). A significant difference was observed between patient groups (PERMANOVA, R2=0.01 139 

p=0.034), but not between treatment groups (PERMANOVA, R2=0.006, p=0.998). For the 140 

treatment sample grouping (A) the group variances were homogeneous, satisfying the 141 

conditions of the PERMANOVA model. This was not the case for the patient sample grouping 142 

(B), indicating that the significant result should be interpreted with caution. 143 

  144 
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 146 

 147 

Supplementary Figure S3. Analysis of microbiota present between paired start and end 148 

time-points collected during the Bcc  trial. Boxplots show the spread of data for Screening 149 

versus End samples, Start OligoG versus End OligoG samples, and Start Placebo versus End 150 

Placebo (S1 samples only, n=78; except 27610-011 that only had S2 for V7). (A) shows the 151 

microbiota diversity measured using the Shannon index; (B) provides the total abundance of 152 

Burkholderia per gram of sputum measured using qPCR, and; (C) shows the relative 153 

abundance of Burkholderia from 16S rRNA gene sequencing analysis. For Shannon Diversity 154 

and total Burkholderia abundance, Wilcoxon signed-rank tests were used to assess the 155 

differences between paired time-points. Differences in relative abundance were determined 156 

using GAMLESS-BEINF models with patient as the random effect, reporting changes in 157 

log(odds ratio) between paired time-points. Statistical significance is shown as a bracket 158 

above boxplots with the p-value under the bracket. 159 

  160 



 161 

 162 

Supplementary Figure S4. Correlation of loss of bacterial diversity with poor lung 163 

function for the Oligo G trial participants. Linear regression was used to examine the 164 

relationship between Shannon diversity and lung function (FEV1 % predicted) for: (A) S1 165 

samples (n=78)  from all 6 time points for the 13 patients on the Bcc trial (except 27610-011 166 

that only had S2 for V7), and (B) S1 samples (n=270) from all 6 time points for the 45 patients 167 

on the P. aeruginosa trial (except 82601-003 that only had S2 for V1). The regression lines 168 

show a trend for decreased lung function with decreased diversity. These trends were not 169 

significant when analysed with linear mixed models with patient as the random effect. 170 
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Supplementary method S1 187 

Standardised protocol 1: Sputum sample processing for DNA extraction 188 

 189 
A) Sample pre-processing 190 

 191 

1. Sputum samples must be processed within 4 weeks of sample collection (stored at 192 

frozen at -80°C in the meantime) 193 

2. Thaw samples at room temperature for 30-45 minutes 194 

 195 

*Label tubes with a Cardiff number and record all sample information* 196 

 197 

3. Weigh samples using an empty collection tube to tare balance. Record the weight to 198 

nearest mg and write on side of tube 199 

 200 

*Record sample weights* 201 

 202 

4. Add 4M guanidine isothiocyanate to sample (1:1 ratio, add equivalent ml to weight 203 

e.g. if 1 g sample, add 1 ml of guanidine isothiocyante) 204 

5. Centrifuge tubes to bring sputum to the bottom (2 minutes; 1409 g) 205 

6. Vortex mix tubes for 30 seconds to 1 minute  206 

*If the sputum is still very viscous incubation at 37°C for 30 minutes to 1 hour can be 207 

performed to thin the consistency* 208 

 209 

B) Bead beating  210 

1. Add 1ml of the sputum mix to 1 g of beads in a 2 ml tube with cap and O-ring  211 

 212 

*if the sputum is viscous it will be difficult to measure 1 ml accurately, in this case just 213 

pipette enough sputum to reach the fill line indicated below* 214 

 215 

 216 

 217 

 218 

 219 

 220 

2. Bead beat for 2 minutes on lowest setting of Beadbug (280 x 10 rpm) 221 

3. Pulse centrifuge to settle beads 222 

 223 

C) DNA extraction 224 

1. Add 400 µl of sputum mix to a Maxwell16® tissue kit cartridge and run DNA 225 

extraction programme on Maxwell16® instrument. In one run, 16 samples can be 226 

processed. 227 

 228 

*Store remaining sputum mix at -80°C in 1.5 ml non-stick eppendorfs* 229 

 230 

2. Collect DNA from Maxwell16® instrument into 1.5 ml non-stick eppendorfs 231 

Fill line 



3. Store 20 µl DNA at 4°C for PCR analyses (short term storage) 232 

4. Store remaining DNA at -20°C (long term storage) 233 

 234 

D) Reagents/consumables/equipment 235 

Reagent/Consumable/Equipment Supplier Product Code 

Beadbug microtube homogenizer Benchmark Scientific D1030 

Triple-pure high impact 100 µm 
zirconium beads 

Benchmark Scientific D1132-01TP 

2 ml bead tubes with caps and seals Benchmark Scientific D1031-T20 
4 M UltraPure™ Guanidine 
Isothiocyanate Solution 

ThermoFisher Scientific 15577018 

Maxwell® 16 System for DNA 
extraction 

Promega AS1250 

Maxwell® Tissue DNA Purification 
kit (48 preps) 

Promega AS1030 

 236 

 237 

 238 

 239 

 240 

 241 

 242 

 243 

 244 

 245 

 246 

 247 

 248 

 249 

 250 

 251 

 252 

 253 

 254 

 255 

 256 



Supplementary method S2 257 

Standardised protocol 2: Identification of Burkholderia species in sputum samples 258 

 259 

A) PCR amplification of recA and gyrB gene sequences 260 

Perform separate PCRs for the amplification of Burkholderia recA and gyrB genes using DNA 261 

extracted from sputum samples (Standardised protocol 1).  262 

 263 

1. Order PCR primers (Spilker et al. 2009) from Eurofins Genomics. Primer sequences are 264 

shown in Table 1. Prepare stock solutions of individual primers at 100 pmol/µl in nuclease 265 

free water according to the synthesis report provided by Eurofins Genomics. Prepare a 266 

working solution of a combination of F and R primers at 10 pmol/µl each in nuclease free 267 

water (for example 30 µl of F primer and 30 µl R primer in a total volume of 300 µl). 268 

 269 

2. Prepare PCR Mastermix for the number of reactions required. This will include the 270 

number of samples, a positive and negative control, and one additional reaction to account 271 

for any pipetting error. Reagent concentrations and volumes for 1 reaction (50 µl) are 272 

shown in Table 2.  273 

 274 

3. Run the PCRs in a thermal cycler with the reaction conditions shown in Table 3. Note that 275 

different annealing temperatures are used for recA and gyrB.  276 

 277 

4. Perform gel electrophoresis to check for successful amplification of gene products. 278 

Prepare a 1.5 % (w/v) gel using molecular grade agarose and Tris-acetate-EDTA (TAE) 279 

buffer, stained with SafeView (NBS Biologicals Ltd.; 10 µl SafeView per 100 ml of agarose 280 

gel). Load 5-10 µl of PCR product and run in TAE buffer at 80V for approximately 1 hour. 281 

Visualise PCR products with a gel imaging system.  282 

 283 

B) PCR product purification and sequencing 284 

1. Purify PCR products using the QIAquick PCR purification kit (Qiagen Ltd.) according to 285 
the manufacturer’s instructions. Load the remaining volume from the PCR for each sample 286 
(approximately 40 – 45 µl) into the kit. 287 

2. Quantify PCR products using the Qubit fluorometer and the Qubit dsDNA BR Assay kit 288 

(ThermoFisher Scientific) according to the manufacturer’s instructions. 289 

 290 

3. Send the PCR products for sequencing with the eurofins genomics sequencing service. 291 

Note that PCR products may need to be diluted to a certain concentration in nuclease free 292 

water before sending, and primers will need to be sent with the PCR products. For both 293 

recA and gyrB send F and R primers to obtain Forward and Reverse sequences for each 294 

sample. 295 

 296 

 297 

 298 



C) Analysis of recA and gyrB sequences 299 

 300 

1. Create consensus recA and gyrB gene sequences from the F and R sequence reads. 301 

Eurofins genomics will email the gene sequences after sequencing has been completed. 302 

Copy and paste the F and R sequences into Notepad and save as .fasta files. Open the 303 

.fasta files with the programme BioEdit (Hall 1999).  304 

 305 

 Highlight the R sequences and select reverse complement from the Sequence tab 306 

(Sequence>Nucleic acid>Reverse Complement) 307 

 Highlight a pair of F and R sequences and create a pairwise alignment (allow ends to slide) 308 

of the F and reverse complemented R sequences (Sequence>Pairwise alignment>Align 309 

two sequences [allow ends to slide]) 310 

 Highlight the F and R sequences and create a consensus sequence (Alignment>Create 311 

Consensus Sequence) and save as a .fasta file (File>Export>Split to Individual Fasta 312 

Files). 313 

 314 

2. Determine the Burkholderia species identity using the BLAST tool on the Burkholderia 315 

Genome Database (www.burkholderia.com) (Winsor et al. 2008). Search the database 316 

using the BLASTN tool and the recA and gyrB consensus sequences. Include all of the 317 

available complete genome sequences in the database in the search. The top database 318 

hits will allow the determination of the species identity. 319 

 320 

Table 1. PCR primers for the amplification of recA and gyrB genes 321 

 322 

All primers are synthesised and supplied by Eurofins Genomics 323 

 324 

Table 2. PCR 325 

reagents for 326 

the 327 

amplification of 328 

recA and gyrB 329 

genes 330 

 331 

 332 

 333 

 334 

 335 

Gene Gene product Primers Sequence 5’>3’ Product size (bp) 

recA Recombinase A 
F AGGACGATTCATGGAAGAWAGC 

704 
R GACGCACYGAYGMRTAGAACTT 

gyrB DNA gyrase B 
F ACCGGTCTGCAYCACCTCGT 

738 
R YTCGTTGWARCTGTCGTTCCACTGC 

Reagent Final concentration (50 µl) Volume 1 reaction (µl) 

H20 - 21.6 
PCR buffer (10X) x1 5.0 

Q-solution (5X) x1 10.0 
Primers (10 pmol/ul) 1.6 uM 8.0 

dNTPs (10 mM each) 240 µm (each) 1.0 
Taq 2U 0.4 
DNA  - 4 

http://www.burkholderia.com/


All reagents are supplied by Qiagen, with the exception of nuclease free H20 which is 336 

supplied by Severn Biotech Ltd. 337 

 338 

 339 

Table 3. PCR reaction 340 

conditions for the 341 

amplification of recA and 342 

gyrB genes 343 

 344 

 345 

 346 

 347 

 348 

 349 

D) PCR reagents and consumables 350 

 351 

Reagent/Consumable Supplier Product Code 

Taq DNA polymerase (Master Mix kit) Qiagen 201203 

Molecular grade water Severn Biotech Ltd. 20-9000-01 

QIAquick PCR purification kit Qiagen 28104 

Qubit dsDNA BR Assay kit Invitrogen Q32853 

Qubit Assay tubes Invitrogen Q32856 

 352 

 353 
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 364 

 365 

 366 

 367 

PCR step Temperature (°C) Time (mins) Cycles 

Initial denaturation 95 2 1 
Denaturation 94 0.5  

30 Annealing 60 (gyrB) 
58 (recA) 

0.5 

Extension 72 1 

Final Extension 72 5 1 
Indefinite hold 10 - - 



Supplementary method S3 368 

Standardised protocol 3: Quantitative PCR (qPCR) using TaqMan probes to determine 369 

bacterial load (Pseudomonas aeruginosa and Burkholderia) 370 

 371 

For qPCR background information please refer to the life technologies Real-time PCR 372 

handbook, which can be found here: http://www.gene-quantification.com/real-time-pcr-373 

handbook-life-technologies-update-flr.pdf. This protocol uses the Chromo4™ system for real-374 

time detection and the Opticon Monitor Software for analysis. The operation manual can be 375 

found here: http://www.bio-rad.com/webroot/web/pdf/lsr/literature/Bulletin_10498.pdf.    The 376 

gyrB gene is used for the quantification of P. aeruginosa and the rpoD gene is used for 377 

Burkholderia. 378 

 379 

A) qPCR standards 380 

 381 

 Reaction efficiency and replicate reproducibility are best assessed through the 382 

generation of a standard curve. This is based on a dilution series of the sample nucleic 383 

acid which is included in the qPCR run. 384 

 This protocol describes the use of PCR products as standards for qPCR. For this, a 385 

DNA fragment larger (>500 bp) than the target qPCR product (generally 100-200 bp) 386 

is amplified by PCR, purified and quantified to determine the concentration (and copy 387 

number) of the target qPCR product per µl of DNA.  388 

 389 

1. Prepare a high concentration ‘stock’ of the qPCR standard for each gene target 390 

o PCR amplify the fragment of DNA containing the target qPCR gene. The PCR 391 

reagents, primers and reaction conditions for the amplification of the rpoD and gyrB 392 

genes are shown in Tables 1, 2 and 3. To obtain a large volume of the DNA fragment, 393 

run 3 x 50 µl reactions and include a negative control. The species used as positive 394 

controls are shown in Table 1. 395 

o Perform standard gel electrophoresis as described in Standardised protocol 2. Load 396 

5 μl of each PCR product. 397 

o Pool the remaining PCR products (45 μl left in each tube, giving a total of 398 

approximately 135 μl) and purify using the QIAquick PCR purification kit (Qiagen Ltd.) 399 

according to the manufacturer’s instructions. 400 

o Quantify PCR products using the Qubit fluorometer (Invitrogen) and Qubit dsDNA BR 401 

Assay kit (Invitrogen) according to the manufacturer’s instructions to obtain a 402 

concentration in ng/µl 403 

o See section E for full details of suppliers of PCR and PCR clean-up and QC reagents 404 

o Calculate the copy number of the target gene using the following equations: 405 

http://www.gene-quantification.com/real-time-pcr-handbook-life-technologies-update-flr.pdf
http://www.gene-quantification.com/real-time-pcr-handbook-life-technologies-update-flr.pdf
http://www.bio-rad.com/webroot/web/pdf/lsr/literature/Bulletin_10498.pdf


 406 

o A concentration of approximately 1010-1011 copies/µl should be obtained from a 407 

successful PCR and purification. Store the stock at -20°C. 408 

 409 

2. Prepare a dilution series 410 

o Use nuclease free water to prepare a dilution series from the stock to cover 102 – 108 411 

copies/µl 412 

o The dilution series should be made up on the day of the qPCR and stored at -20°C 413 

for no longer than 24 hours before being discarded. Ideally a fresh dilution series 414 

should be made for each qPCR run. Using the Qubit fluorometer, quantify the 1010 415 

copies/µl dilution of each dilution series to accurately calculate the copy number for 416 

the lower dilutions. 417 

 418 

Table 1. PCR primers for the amplification of qPCR standards 419 

Gene Primers Sequence 5’>3’ Product size (bp) Positive control species 

rpoD 
F GATCTTGCACATCGTCGTC 

1011 
Burkholderia cenocepacia 

(J2315) R GTTCGTAACGGAGACGCTG 

gyrB 
F GAGTCGATCACTGTCCGC 

1186 
Pseudomonas aeruginosa 

(PAO1) R GCATCTTGTCGAAGCGCG 

All primers are synthesised and supplied by Eurofins Genomics; refer to Standardised 420 

protocol 2 for preparation of primer stock solutions. 421 

 422 

Table 2. PCR reagents for the amplification of qPCR standards 423 

 424 

 425 

 426 

 427 

 428 

All reagents are supplied by Qiagen, with the exception of nuclease free H20 which is 429 

supplied by Severn Biotech Ltd. Refer to Standardised protocol 2 for preparation of PCR 430 

Mastermix. 431 

 432 

 433 

Reagent Final concentration Volume 1 reaction (µl) 

H20 - 21.6 
PCR buffer (10X) x1 5.0 

Q-solution (5X) x1 10.0 
Primers (10 pmol/ul) 1.6 uM 8.0 

dNTPs (10 mM each) 240 µm (each) 1.0 
Taq 2U 0.4 
DNA  - 4 



Table 3. PCR reaction conditions for the amplification of qPCR standards 434 

 435 

 436 

 437 

 438 

 439 

B) qPCR 440 

 441 

1. Set up the Chromo4™ real-time detector. Using the Opticon Monitor Software, edit the 442 

plate layout and reaction conditions for the qPCR run. An example 96 well-plate layout 443 

is shown below in Figure 1. Under Master>Plate Setup>Edit>Specify Quant Standards, 444 

the copies/µl of each of the standards can be entered. Under Master>Plate 445 

Setup>Edit>Sets, replicates can be grouped together into sets and given an ID. The 446 

reaction conditions for the 16S rRNA, rpoD and gyrB gene qPCRs are shown in Table 447 

4. 448 

 449 

 450 

 451 

 452 
 453 

Figure 1. Example qPCR plate layout on the Opticon Monitor Software. Standards, 454 

samples and blanks are run in triplicate. The passive reference (PR) dye ROX is a 455 

component of the qPCR Mastermix and this is highlighted for each well. 456 

 457 

 458 

 459 

 460 

 461 

PCR step Temperature (°C) Time (mins) Cycles 

Initial denaturation 95 2 1 
Denaturation 94 0.5  

30 Annealing 59 (rpoD) 
58 (gyrB) 

0.5 

Extension 72 1 
Final Extension 72 5 1 
Indefinite hold 10 - - 



Table 4. qPCR reaction conditions for the amplification of rpoD and gyrB genes 462 

Step Time Temp (°C) No cycles 

UNG treatment 3 min 50 1 
Taq activation 10 min 95 1 

Denaturation 15 secs 95 

40 Annealing and Extension 
30 secs (rpoD)  
30 secs (gyrB) 

67 
60 

Plate Read 

Hold 10 mins 25 1 

 463 

2. Prepare the qPCR Mastermix for the number of reactions required, bearing in mind 464 

that everything is performed in triplicate. This will include the 102 – 108 dilution series, 465 

the samples and the blanks. Add an extra reaction to account for any pipetting error. 466 

The qPCR primers and TaqMan probes, and reagents are shown in Tables 5 and 6, 467 

respectively. 468 

3. Load the Mastermix into the qPCR plate, 9 µl into each well. 469 

4. Load the standards, blanks and samples into the qPCR plate, 1 µl into each well. 470 

5. Seal the plate with a plate seal and pulse centrifuge the plate to draw the liquid to the 471 

bottom of the wells 472 

6. Transfer the plate into the qPCR machine and run the qPCR. The qPCR plate can be 473 

discarded once the run is complete. 474 

 475 

 476 

Table 5. qPCR primers and TaqMan probes for the amplification of rpoD and gyrB genes 477 

 478 

 479 

Table 6. qPCR Mastermix: reagents for the amplification of 16S rRNA, rpoD and gyrB genes 480 

 481 

 482 

 483 

 484 

*See Section E for the suppliers of the qPCR Supermix and TaqMan Probes 485 

 486 

 487 

 488 

 489 

Gene Primers/Probe Sequence 5’>3’ Product size (bp) Reference 

rpoD 

F GAGATGAGCACCGATCACAC 

143 

(Sass et al. 
2013) R CCTTCGAGGAACGACTTCAG 

PROBE 5’FAM-CTGCGCAAGCTGCGTCACC-3’MGBNFQ This study 

gyrB 

F CCTGACCATCCGTCGCCACAAC 

220 
(Anuj et al. 
2009) 

R CGCAGCAGGATGCCGACGCC 

PROBE 
5’FAM-
GGTCTGGGAACAGGTCTACCACCACGG-
3’MGBNFQ 

Reagent Final concentration Volume 1 reaction (µl) 

qPCR Supermix with ROX (2X)* 1X 5 
F&R primers (10 pmol/µl) 1.8 µM 1.8 

TaqMan Probe (100 pmol/µl) [FAM]* 225 nM 0.0225 
H2O - 2.1775 



C. Analysis of qPCR results in Opticon Monitor Software 490 

 In the Opticon Monitor Software click the ‘Quantitation’ view to see the results. This 491 

view will show you the plate layout, wells and sets, and the data and standards graphs. 492 

An example is shown in Figure 2. 493 

 To calculate the efficiency of the qPCR amplification, use the slope of the standard 494 

curve and the below equation.  The ‘Toggle Axis’ box needs to be checked to get the 495 

correct x value to use in the equation. The acceptable range is 90 -110%. 496 

qPCR reaction efficiency = [10(-1/slope of standard curve) – 1] x 100 497 

qPCR reaction efficiency (Figure 2) = [10(-1/-3.429) -1] x 100 = 95.7% 498 

 The R2 value is a measure of replicate reproducibility and should ideally be above 0.98 499 

(98%). The R2 value from Figure 2 is 0.999 (99.9%) 500 

 If you are satisfied with the efficiency and R2 values move on to processing the data 501 

 502 

 503 

 504 

Figure 2. qPCR results under the ‘Quantitation’ view in Opticon Monitor Software. The data 505 

graph in the bottom left hand window displays the fluorescence curves of the standards, the 506 

bottom right hand window displays the standard curve from which the efficiency and R2 values 507 

can be obtained.  508 

 509 

 To view the results from all of the wells, highlight all of the wells in the ‘Plate’ section, 510 

and all of the sets in the ‘Graphed Samples’ section. Select Quantitation>Copy to 511 

Clipboard>Quantity calculations, and paste this into an Excel spreadsheet.  512 

 Look at the triplicate results for each sample and calculate the coefficient of variation 513 

(CV = standard deviation/mean). If the CV is equal to or less than 20% then the mean 514 

of the three results can be taken. If the CV is higher than 20% examine the results 515 



further. If two results within a triplicate set are within 0.2 log of each other, the mean of 516 

these two results is taken, and the third ‘anomalous’ result is excluded from the 517 

dataset. If assays do not meet these criteria, they are considered unacceptable and 518 

the qPCR re-run for the sample.  A full explanation of these criteria can be found in 519 

(Zemanick et al. 2010). 520 

 Opticon Monitor Software will perform preliminary analysis of replicate sets for you, 521 

allowing you to observe the average C(t), the average copy number, and some basic 522 

statistics for each set of replicates. Remove wells with anomalous results from the sets 523 

under the Master>Plate Setup>Edit>Sets, return to the Quantitation view, highlight all 524 

of the sets in the Graphed Samples section, and select Quantitation>Copy to 525 

Clipboard>Quantity calculations, and paste this into an Excel spreadsheet.  526 

 527 

D. Statistical analysis of qPCR results 528 

 There should be at least 3 qPCR runs (3 biological replicates) per sample. These 529 

results can be used for further statistical analyses. 530 

 The results obtained are gene copy per μl of DNA (equivalent to cell number) extracted 531 

from a sputum sample. Perform the necessary calculations to obtain the number of 532 

gene copies (cell number) per gram of sputum for comparisons. 533 

 534 

E. Reagents and consumables 535 

Table 7. qPCR Reagents and consumables 536 

Reagent/Consumable Supplier Product Code 

Preparation of qPCR standards 
Taq DNA polymerase 
(Master Mix kit) 

Qiagen 201203 

Molecular grade water Severn Biotech Ltd. 20-9000-01 
QIAquick PCR 
purification kit 

Qiagen 28104 

Qubit dsDNA BR 
Assay kit 

Invitrogen Q32853 

Qubit Assay tubes Invitrogen Q32856 
qPCR 

Platinum qPCR 
supermix-UDG w/Rox 

Life Technologies 
(Thermo Fisher Scientific) 

11743-500 

Custom TaqMan probe 
(5’FAM, 3’MGBNFQ) ThermoFisher Scientific 

Order online: 
https://www.thermofisher.com/order/c
ustom-oligo/custom-taqman-probes 

Hard-Shell low-profile 
Thin-wall 96-well 
skirted PCR plates 
(black shell white well) 

BioRad HSP9665 

Sealing film for real 
time PCR (50 µm thick) 

ELKAY SEA-LPTS-RT2 

 537 

 538 

 539 



References 540 

 541 

Anuj, S. N., Whiley, D. M., Kidd, T. J., Bell, S. C., Wainwright, C. E., Nissen, M. D. and Sloots, 542 
T. P. (2009). Identification of Pseudomonas aeruginosa by a duplex real-time polymerase 543 
chain reaction assay targeting the ecfX and the gyrB genes. Diagnostic Microbiology and 544 
Infectious Disease 63:127-131. 545 

 546 
Sass, A. M., Schmerk, C., Agnoli, K., Norville, P. J., Eberl, L., Valvano, M. A. and 547 
Mahenthiralingam, E. (2013). The unexpected discovery of a novel low-oxygen-activated 548 
locus for the anoxic persistence of Burkholderia cenocepacia. Isme j 7:1568-1581. 549 

 550 
Zemanick, E. T., Wagner, B. D., Sagel, S. D., Stevens, M. J., Accurso, F. J. and Harris, J. K. 551 
(2010). Reliability of quantitative real-time PCR for bacterial detection in cystic fibrosis airway 552 
specimens. PLoS One 5. 553 

 554 

 555 

 556 

 557 

 558 

 559 

 560 

 561 

 562 

 563 

 564 

 565 

 566 

 567 

 568 

 569 

 570 

 571 

 572 

 573 

 574 

 575 



Supplementary method S4 576 

Standardised protocol 4: Ribosomal RNA Intergenic Spacer Analysis (RISA) 577 

 578 
The region between the small and large subunit rRNA genes, the 16S rRNA and 23S rRNA 579 
gene for bacteria, is known as the Intergenic Transcribed Spacer (ITS). This region varies in 580 
length and sequence and is the basis of RISA (Fisher and Triplett 1999).  RISA profiles provide 581 
the following information about bacterial diversity in polymicrobial samples: (i) the number of 582 
RISA bands is a qualitative measure of the taxonomic diversity present; (ii) the size of the ITS 583 
amplicon may be correlated to a known species/genera, especially if run alongside a positive 584 
control, and provide a presumptive taxonomic identification; and (iii) the RISA profiles are 585 
semi-quantitative, with the ITS band intensity correlating to the amount of DNA template and 586 
hence the approximate proportion of the original organism present in the sputum sample. 587 
 588 
This protocol describes the use of RISA to check quality of the DNA extracted from sputum 589 
(Standardised protocol 1), i.e. to determine if there is sufficient bacterial DNA for a positive 590 
PCR result, and to get a preliminary idea of the bacterial diversity in a sputum sample. 591 
 592 
 593 
A) RISA-PCR 594 
 595 
5. RISA-PCR primers are shown in Table 1, please refer to Standardised protocol 2 for more 596 

details on primer stock preparation. 597 

6. Prepare the RISA-PCR Mastermix for the number of reactions required. This will include 598 

the number of samples, a positive and negative control, and one additional reaction to 599 

account for any pipetting error. PCR primers, reagent concentrations and volumes for 1 600 

reaction (25 µl) are shown in Table 2. Control DNA from Pseudomonas aeruginosa, 601 

Burkholderia spp. and other bacterial species linked with cystic fibrosis can also be run to 602 

produce control products for profile analysis. 603 

7. Run the RISA-PCR in a thermal cycler with the PCR conditions shown in Table 3. 604 

8. Perform standard gel electrophoresis to check for successful amplification of PCR 605 

products 606 

 607 
 608 
Table 1. PCR primers for the amplification of the bacterial ITS region 609 
 610 

Primer Sequence (5’ > 3’) Comment Reference 

1406F TGYACACACCGCCCGT Degenerate RISA 
primers 

Fisher & Triplett 
(1999) 23SR GGGTTBCCCCATTCRG 

All primers are synthesised and supplied by Eurofins Genomics 611 

 612 

 613 

 614 

 615 

 616 

 617 



Table 2. PCR reagents for the amplification of the bacterial ITS region 618 
 619 

 620 

 621 

 622 

 623 

 624 

 625 

 626 

All reagents are supplied by Qiagen, with the exception of nuclease free H20 which is 627 

supplied by Severn Biotech Ltd. 628 

 629 

Table 3. PCR reaction conditions for the amplification of the bacterial ITS region 630 

 631 

 632 

 633 

 634 
 635 

 636 

 637 

 638 

B) Microfluidic separation and cluster analysis of RISA-PCR profiles 639 

 640 

1. Run RISA-PCR products on an Agilent BioAnalyzer (Agilent Technologies UK Ltd., 641 

Cheshire, United Kingdom) using a DNA 7500 chip according to the manufacturer’s 642 

instructions.  643 

2. Import BioAnalyzer profiles into Bionumerics software (Applied Maths, Gent, Belgium) for 644 

analysis. A dedicated script has been provided to Cardiff University by Applied Maths to 645 

convert BioAnalyzer profiles to a format compatible with Bionumerics. 646 

3. Cluster analysis is performed in Bionumerics to compare the RISA-PCR profiles. 647 

Similarities between RISA are calculated using the Pearson coefficient, and dendrograms 648 

constructed by the unweighted-pair group method using average linkages (UPGMA). It is 649 

also possible to view the profiles as a composite image to look at the patient samples in 650 

chronological order. Changes in overall diversity can be observed by looking at the number 651 

and sizes of bands within the profile. 652 

4. The size of specific RISA amplicons can be determined using the BioAnalyzer and 653 

correlated to specific bacterial genera using the In Silico PCR database (website 654 

http://insilico.ehu.es/PCR)(Bikandi et al. 2004). The intergenic spacer sizes can be 655 

recorded for strains and species of interest (examples are shown in Table 4). It is not 656 

Reagent Final concentration (25 
ul) 

Volume 1 reaction (ul) 

H20 - 13.8 
PCR buffer (10X) x1 2.5 
Q-solution (5X) x1 5.0 
Primers (10 
pmol/ul) 

0.4 uM 1.0 

dNTPs (10 mM 
each) 

240 um (each) 0.5 

Taq 2U 0.2 
DNA  - 2 

PCR step Temperature 
(°C) 

Time 
(mins) 

Cycles 

Initial 
denaturation 

95 5 1 

Denaturation 95 1  
35 Annealing 54 0.5 

Extension 72 1 
Final Extension 72 5 1 
Indefinite hold 10 - - 

http://insilico.ehu.es/PCR


always possible to identify bands within the RISA profile as certain species, but bands of 657 

certain sizes can be useful markers to look out for. 658 

 659 

Table 4. Intergenic transcribed spacer (ITS) sizes (bp) for a selection of bacterial species 660 

and strains associated with cystic fibrosis 661 

 662 

 663 

 664 

C) Reagents/consumables/equipment 665 

Reagent/Consumable Supplier Product Code 

Taq DNA polymerase 
(Master Mix kit) 

Qiagen 201203 

Molecular grade water Severn Biotech Ltd. 20-9000-01 
2100 Bioanalyzer 
instrument 

Agilent G2939B 

Agilent DNA 7500 kit Agilent 5067-1506 
Agilent 7500 reagents Agilent 5067-1507 

 666 

 667 
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 677 

 678 

\ 679 

 680 

Species/strain ITS size(s) (bp) 

Pseudomonas aeruginosa 753 
Burkholderia ambifaria  AMMD 681, 827, 830, 871 
Burkholderia cenocepacia J2315 677, 812, 816 

Burkholderia multivorans ATCC 
17616 

829, 830, 883 

Haemophilus influenzae 995-1015, 757-759 
Ralstonia mannitolytica 805 
Ralstonia pickettii  796-797 
Stenotrophomonas maltophilia 777-782, 826-829 
Achromobacter xylosoxidans 887-891, 1021 



Supplementary method S5 681 

Standardised protocol 5: Bacterial diversity analysis (16S rRNA gene sequencing and 682 

analysis) 683 

  684 

A) Extract DNA from the samples to be sent for 16S rRNA sequencing and bacterial diversity 685 

analysis (Standardised protocol 1). 686 

 687 

B) Check DNA quality by performing a RISA PCR (Standardised protocol 3). This will 688 

determine whether there is sufficient DNA for a positive PCR result and will also give some 689 

preliminary information about bacterial diversity.  690 

 691 

C) Sample submission to the commercial company Research and Testing Laboratory Inc. 692 

(Lubbock, Texas, USA; http://www.researchandtesting.com). Sample submission 693 

guidelines can be found online and a submission spreadsheet will need to be completed 694 

and sent back. Samples are sent via a courier to the company. Research and Testing 695 

perform Illumina MiSeq sequencing of the 16S rRNA gene V1-V2 regions and on 696 

completion will email a web link which can be used to retrieve the data. 697 

 698 

D) Data processing and analysis in Mothur (version 1.33) 699 

Mothur is a bioinformatics program for analysing microbial communities that is being 700 

developed by Schloss lab at the University of Michigan. This protocol has been adapted from 701 

the MiSeq SOP found at http://www.mothur.org/wiki/MiSeq_SOP#OTU-based_analysis to 702 

process 16S rRNA gene sequences that are generated using Illimina’s MiSeq platform using 703 

paired end reads. Please refer to this website for a more detailed description of the pipeline 704 

steps. 705 

1. Preparing the files for Mothur 706 

Based on Illumina’s MiSeq platform, there are two fastq files generated for each sample. The 707 

R1 file corresponds to read 1 (forward read) and the R2 file corresponds to read 2 (reverse 708 

read). It may be useful to rename these files (e.g. example_R1, example_R2) before starting 709 

the Mothur pipeline as the original file names can be very long.  710 

These fastq files then need to be paired up for each sample.  Using Microsoft Excel in 711 

windows, make a spreadsheet with 3 columns but no headings. Column A is sample name, 712 

column B is R1 file name and column C is R2 file name. Save this as a .txt. file. This file 713 

specifies which fastq files to pair together. Copy the .txt file and all of the sequence files over 714 

to the directory that you will be using on the linux platform. 715 

 Move to the linux platform and navigate to the directory where your sequence files and 716 

the .txt file that you have just created is stored. In Mothur use the make.contigs command 717 

to extract the sequence and quality score data from your fastq files, create the reverse 718 

complement of the reverse read and then join the reads into contigs. 719 

 720 

mothur > make.contigs (file=example.txt, processors=4) 721 

 722 

http://www.researchandtesting.com/
http://www.mothur.org/wiki/MiSeq_SOP#OTU-based_analysis


This command also produces several files that you will need later: example.trim.contigs.fasta 723 

and example.contigs.groups. These contain the sequence data and group identity for each 724 

sequence. Note that ‘groups’ actually refers to samples in Mothur. The example.contigs.report 725 

file will tell you something about the contig assembly for each read. 726 

Look at a summary of the sequences: 727 

mothur > summary.seqs (fasta=example.trim.contigs.fasta, processors=4) 728 

 729 

Example output: 730 

 731 

2. Reducing sequencing and PCR errors 732 

 733 

 Remove sequences with ambiguous bases and filter sequences based on different 734 

criteria using the screen.seqs command. The criteria will vary depending on the 735 

sequence data. 736 

mothur > screen.seqs(fasta=example.trim.contigs.fasta, group=example.contigs.groups, 737 

summary=example.trim.contigs.summary, maxn=0, maxambig=0, maxhomop=7, 738 

minlength=342, maxlength=360) 739 

 Re-summarise the sequences after filtering 740 

mothur > summary.seqs (fasta=example.trim.contigs.good.fasta, processors=4) 741 

Example output: 742 

 743 

 744 

3. Processing improved sequences 745 

 746 

 Remove duplicate sequences using the unique.seqs command. 747 



mothur > unique.seqs(fasta=example.trim.contigs.good.fasta)  748 

 Run the count.seqs command to generate a table where the rows are the names of the 749 

unique sequences and the columns are the names of the groups. The table is then filled 750 

with the number of times each unique sequence shows up in each group. 751 

mothur > count.seqs(name=example.trim.contigs.good.names, 752 

group=example.contigs.good.groups) 753 

 Re-summarise the sequences and observe the number of unique sequences 754 

mothur > summary.seqs (count=example.trim.contigs.good.count_table) 755 

Example output: 756 

 757 

 View the number of sequences in each sample. The following command will output a list 758 

of samples and the number of sequence reads per sample. 759 

mothur > count.groups(count=example.trim.contigs.good.count_table) 760 

 Align the sequences to a customised reference alignment of bacterial sequences. This 761 

reference alignment (silva.bacteria.fasta) must be downloaded into the directory you are 762 

working from and is available here: http://www.mothur.org/wiki/Silva_reference_files  763 

mothur > align.seqs(fasta=example.trim.contigs.good.unique.fasta, 764 

reference=silva.bacteria.fasta, processors=10 765 

 Summarise the quality of the sequences after making the alignment 766 

mothur > summary.seqs(fasta=example.trim.contigs.good.unique.align, 767 

count=example.trim.contigs.good.count_table, processors=10) 768 

 769 

 770 

http://www.mothur.org/wiki/Silva_reference_files


 Some sequences may start and end at the same position indicating a very poor alignment, 771 

which is generally due to non-specific amplification. To make sure that everything overlaps 772 

the same region re-run screen.seqs to get rid of sequences that start at or before position 773 

1044 and end at or after position 6424, i.e. the start and end values that correspond to the 774 

25%-tile and 75%-tile.  775 

 Include the count table to update the table for the sequences we are removing.  Include 776 

the summary file so we do not have to figure out again all the start and stop positions.  777 

mothur > screen.seqs(fasta=example.trim.contigs.good.unique.align, 778 

count=example.trim.contigs.good.count_table, 779 

summary=example.trim.contigs.good.unique.summary, start=1044, end=6424, 780 

maxhomop=7) 781 

 Summarise the sequence data 782 

mothur > summary.seqs(fasta=current, count=current) 783 

Example output: 784 

 785 

 Filter the sequences to remove the overhangs at both ends even though paired-end 786 

sequencing should not be an issue. In addition, any column that contains gap characters 787 

e.g. “-“will be removed 788 

 The command filter.seqs removes columns from alignments based on a criteria defined 789 

by the user. For example, alignments generated against reference alignments (e.g. from 790 

RDP, SILVA, or greengenes) often have columns where every character is either a '.' or a 791 

'-'. These columns are not included in calculating distances because they have no 792 

information in them. 793 

 Vertical = T: any column that only contains gap characters is ignored. This can be turned 794 

off by setting vertical to F. 795 

 Trump  =.: trump option will remove a column if the trump character is found at that position 796 

in any sequence of the alignment.  797 

mothur > filter.seqs(fasta=example.trim.contigs.good.unique.good.align, vertical=T, 798 

trump=.) 799 

Example output: 800 

 801 



 According to the output, this means that our initial alignment was 50000 columns wide and 802 

that we were able to remove 49196 terminal gap characters using trump=. and vertical gap 803 

characters using vertical=T. The final alignment length is 804 columns. Because some 804 

redundancy has been created across our sequences by trimming the ends, re-run 805 

unique.seqs 806 

mothur > unique.seqs(fasta=example.trim.contigs.good.unique.good.filter.fasta, 807 

count=example.trim.contigs.good.good.count_table) 808 

 Further de-noise the sequences using the pre.cluster command, which implements a 809 

pseudo-single linkage algorithm with the goal of removing sequences that are likely due 810 

to sequencing errors 811 

mothur > pre.cluster(fasta=example.trim.contigs.good.unique.good.filter.unique.fasta, 812 

count=example.trim.contigs.good.unique.good.filter.count_table, diffs=2, processors=10) 813 

mothur > 814 

chimera.uchime(fasta=example.trim.contigs.good.unique.good.filter.unique.precluster.fasta, 815 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.count_table, 816 

dereplicate=t) 817 

mothur > 818 

remove.seqs(fasta=example.trim.contigs.good.unique.good.filter.unique.precluster.fasta, 819 

accnos=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.accnos) 820 

Example output: 821 

Removed 43166 sequences from your fasta file. 822 

 823 

 Re-summarise the sequence data 824 

 825 

 The split.abund command reads a fasta file and a list or a names file splits the sequences 826 

into rare and abundant groups. 827 

mothur > 828 

split.abund(fasta=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.fasta, 829 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.pick.count_tab830 

le, cutoff=2) 831 

 The classify.seqs command allows you to use several different methods to assign their 832 

sequences to the taxonomy outline of their choice. Current methods include using a k-833 



nearest neighbor consensus and Wang approach. The command requires that you provide 834 

a fasta-formatted input and database sequence file (trainset10_082014.rdp.fasta) and a 835 

taxonomy file (trainset10_082014.rdp.tax) for the reference sequences. These can be 836 

downloaded from the following website: http://www.mothur.org/wiki/RDP_reference_files  837 

mothur > 838 

classify.seqs(fasta=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abun839 

d.fasta, 840 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.pick.abund.co841 

unt_table, reference=trainset10_082014.rdp.fasta, taxonomy=trainset10_082014.rdp.tax, 842 

cutoff=80, processors=10) 843 

 Next, since bacterial 16S rRNA sequences were amplified, anything classified as species 844 

other than bacteria (e.g. mitochondria, archaea, etc.) have to be removed. 845 

 The remove.lineage command reads a taxonomy file and a taxon and generates a new 846 

file that contains only the sequences not containing that taxon. You may also include 847 

either a fasta, name, group, list, count or align.report file to this command and Mothur will 848 

generate new files for each of those that contains only the sequences not containing that 849 

taxon. 850 

mothur > 851 

remove.lineage(fasta=example.trim.contigs.good.unique.good.filter.unique.precluster.pic852 

k.abund.fasta, 853 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.pick.abund854 

.count_table, 855 

taxonomy=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abund.rdp856 

.wang.taxonomy, taxon=Chloroplast-Mitochondria-unknown-Archaea-Eukaryota) 857 

 The cluster.split command can be used to assign sequences to OTUs and outputs a 858 

.list, .rabund, .sabund files. It splits large distance matrices into smaller pieces 859 

mothur > 860 

cluster.split(fasta=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.ab861 

und.pick.fasta, 862 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.pick.abund863 

.pick.count_table, 864 

taxonomy=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abund.rdp865 

.wang.pick.taxonomy, splitmethod=classify, taxlevel=4, cutoff=0.15, processors=10) 866 

 Observe the number of sequences left 867 

mothur > count.groups(count=current) 868 

 869 

4. Preparing for analysis 870 

 871 

 Create a shared file, which has samples in columns and OTUs in rows and displays the 872 

count of each OTU in each sample. From this we can see how many sequences are in 873 

each OTU from each group and tell Mothur that we're really only interested in the 0.03 874 

cutoff level: 875 

http://www.mothur.org/wiki/RDP_reference_files
http://www.mothur.org/wiki/Fasta_file
http://www.mothur.org/wiki/Fasta_file
http://www.mothur.org/wiki/Name_file
http://www.mothur.org/wiki/Name_file
http://www.mothur.org/wiki/Group_file
http://www.mothur.org/wiki/Group_file
http://www.mothur.org/wiki/List_file
http://www.mothur.org/wiki/List_file
http://www.mothur.org/wiki/Count_File
http://www.mothur.org/wiki/Count_File
http://www.mothur.org/w/index.php?title=Align.report_file&action=edit&redlink=1
http://www.mothur.org/w/index.php?title=Align.report_file&action=edit&redlink=1


mothur > 876 

make.shared(list=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.ab877 

und.pick.an.unique_list.list, 878 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.pick.abund879 

.pick.count_table, label=0.03) 880 

 Get the consensus taxonomy for each OTU using the classify.otu command 881 

mothur > 882 

classify.otu(list=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abun883 

d.pick.an.unique_list.list, 884 

count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchime.pick.abund885 

.pick.count_table, 886 

taxonomy=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abund.rdp887 

.wang.pick.taxonomy, label=0.03) 888 

 Check the number of sequences in each sample 889 

mothur > 890 

count.groups(count=example.trim.contigs.good.unique.good.filter.unique.precluster.uchi891 

me.pick.abund.pick.count_table) 892 

 Subsampling the data ensures that each sample has the same number of reads for 893 

downstream analyses. This is done by sub.sample. At this point, you need to decide what 894 

to normalize all the reads in each sample to. If you do not specify “size=…” in the 895 

command, then Mothur will look at all your groups and find the one with the lowest number 896 

of reads and sub-sample everything to it, this is shown below: 897 

mothur > 898 

sub.sample(shared=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.899 

abund.pick.an.unique_list.shared) 900 

 In the case that there is a sample with an extremely low number of read, specify and 901 

subsample by a suitable size by changing XXX in the following command to the size that 902 

you prefer in this command (the minimum read number used should be >1000): 903 

mothur > 904 

sub.sample(shared=example.trim.contigs.good.unique.good.filter.unique.precluster.pick.905 

abund.pick.an.unique_list.shared, size=XXX 906 

 907 

 Rename the very long file names to simpler ones. This can be done by the following 908 

command, which basically makes a copy of the file using the name you specified. The final 909 

files will all have .pick.pick near the end. Do this for the .groups, .list, and subample.shared 910 

files. The final .fasta file will come from a subsequent step (the get.oturep step in stage 5). 911 

The example below shows the command for renaming the .list file: 912 

 913 

mothur > system (rename 914 

example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abund.pick.an.uniqu915 

e_list.list example.final.list) 916 

 917 

http://www.mothur.org/wiki/Classify.otu


 Alternatively, quit mothur and use the cp command to copy of the file and rename the 918 

copy you have made. You will need to start the mothur software again once you have 919 

copied the files. Example commands are shown below. The first command exits mothur, 920 

the second command copies and renames the file (.list in this example), and the third 921 

command re-starts mothur. 922 

 923 

mothur > quit 924 

> cp 925 

example.trim.contigs.good.unique.good.filter.unique.precluster.pick.abund.pick.an.uniqu926 

e_list.list example.final.list 927 

> mothur 928 

 929 

 930 

5. Analysis 931 

 932 

 Obtain a summary file. The summary.single command produces a table containing the 933 

number of sequences, alpha diversity indices and the sample coverage. Although the 934 

downstream analyses (alpha and beta diversity) will be performed using R statistical 935 

software (R-Core-Team 2013)(http://www.R-project.org), this summary is useful to gain an 936 

overview of the sample statistics. 937 

mothur > summary.single(shared=example.final.shared, calc=nseqs-sobs-chao-ace-938 

invsimpson-npshannon-coverage) 939 

 The get.oturep command generates a fasta-formatted sequence file containing only a 940 

representative sequence for each OTU.  941 

mothur > get.oturep(phylip=example.final.phylip.dist, list=example.final.list, 942 

fasta=example.final.fasta, label=0.03) 943 

 Transfer the following files from the linux platform to windows: 944 

1. example.final.0.03.rep.fasta 945 

2. example.final.groups.summary 946 

3. example.final.shared 947 

 948 

 The remaining actions are performed in windows 949 

 Open example.final.shared in notepad++ , copy and paste in Excel, then copy and paste 950 

(transpose) into a new sheet. Insert 1 column at the start labelled Genus. Save this 951 

spreadsheet  e.g. DiversityResults.xlsx 952 

 Open the example.final.fasta file in notepad++ and remove all of the ‘-‘ symbols. This can 953 

be done using the find and replace tool, replacing ‘-‘ with a backspace. 954 

 Download RDP Classifier files from https://sourceforge.net/projects/rdp-classifier/ and 955 

save in a logical location. Copy and paste the example.final.0.03.rep.fasta into the same 956 

file as the Classifier executable jar file 957 

 NOTE: In order to run the following script you will need Java (download  jre-7u60-958 

windows-x64.exe) 959 

 Open dos terminal (type cmd into windows search) and navigate to the location of the 960 

classifier exe jar file and the example.final.0.03.rep.fasta file 961 

http://www.r-project.org/
https://sourceforge.net/projects/rdp-classifier/


cd To change directory within a drive   962 

d: To change drive (example shown here is to change to D drive) 963 

 Run the classifier exe jar file to find the OTUs to the genus level. This creates two 964 

new files (outfile in the script) 965 

java -Xmx1g -jar Classifier.jar --conf=0.5 --hier_outfile=example_unclassified_hier.txt --966 

assign_outfile=example_unclassified_detail.txt --format=fixrank example.final.0.03.rep.fasta 967 

 N.B. The ‘--assign_outfile=’ command may need to be written as ‘--outputFile=’ 968 

 Open example_unclassified_detail in Excel, copy and paste the genus column into the 969 

DiversityResults.xlsx genus column. As the DiversityResults.xlsx genus column was 970 

created from the subsampled sequences (OTUs) and the example_unclassified_detail 971 

file contains genera identified from ALL of the OTUs found in the samples , there will 972 

likely be more genera than OTUs. You will need to delete the genera corresponding to 973 

removed OTUs for the spreadsheet to make sense. This is not difficult as the genera 974 

and OTUs are organised numerically in Excel (smallest to largest).  975 

 N.B. To further validate the genus IDs for each OTU the sequences from the 976 

example.final.0.03.rep.fasta file can be used to search the RDP-II sequence database 977 

(http://rdp.cme.msu.edu/) 978 

 You now have a spreadsheet containing OTUs, genera and number of sequence reads 979 

per sample. Remove any genera appearing with less than 10 reads across the sample 980 

set. 981 

 Consolidate OTUs to genus level. 982 

 This spreadsheet can be used to calculate relative abundance of genera for a sample 983 

by looking at the % of sequence reads each genus holds. Barcharts can be created in 984 

Excel to visualise the data. 985 

 Further data analysis (alpha and beta diversity, statistical differences between factors 986 

for sample groups) is performed using R statistical software using this spreadsheet 987 

and associated metadata. 988 

 989 
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Supplementary method S6 1002 

R scripts for statistical analysis of microbiota data 1003 

 1004 

The following R scripts can be used in conjunction with different spreadsheets to analyse 1005 

microbiota data. The format of the spreadsheets is described, along with the R commands for 1006 

each analysis performed in the paper. The examples used are for the Bcc trial data. 1007 

 1008 

1) R packages needed 1009 

The following R packages are needed for all the analysis and data visualisation 1010 

library(vegan) 1011 

library(goeveg) 1012 

library(car) 1013 

library(psych) 1014 

library(lattice) 1015 

library(FSA) 1016 

library(PMCMR) 1017 

library(ggplot2) 1018 

library(cowplot) 1019 

library(gamlss) 1020 

library(dplyr) 1021 

library(funrar) 1022 

library(NMF) 1023 

library(RColorBrewer) 1024 

library(colorspace) 1025 

library(nlme) 1026 

 1027 

2) Read in OTU tables and metadata spreadsheets 1028 

#OTU table: Compile an excel spreadsheet with genus/OTU as column 1 without a 1029 

heading. All the other columns have sample number as a heading and read numbers in 1030 

rows corresponding to the genus/OTU in column 1. Save as a .txt file and read into R. 1031 

data<-read.table(file.choose(), header=T) 1032 

#Metadata table: Compile a spreadsheet with sample number as column 1. All other 1033 

columns contain metadata (e.g. Patient number, Treatment group, qPCR total 1034 

abundance, Shannon.diversity, Relative abundance of a key pathogen, FEV1). All 1035 

columns have headings. Save as a .csv file and read into R. 1036 

meta_table<-read.csv(file.choose(),row.names=1,check.names=FALSE) 1037 



3) Calculate Shannon diversity and save as a new file 1038 

data_transpose<-t(data)   1039 

matrix_data<-data.matrix(data_transpose) 1040 

shannon.diversity <- diversity(matrix_data, "shannon") 1041 

shannon.results<-as.data.frame(shannon.diversity) 1042 

write.csv(shannon.results, "PATH/TO/FILE/Shannon_diversity_results.csv") 1043 

 1044 
#Shannon diversity data: Shannon diversity values can be added into the metadata 1045 

spreadsheet before reading to R for analysis. 1046 

 1047 

4) NMDS ordination plot of Bray-Curtis dissimilarity values 1048 

#Format data 1049 

abund_table<-t(data) 1050 

meta_table$Treatment<-factor(meta_table$Treatment, levels = c("Screening", 1051 

"Start_OligoG", "End_OligoG","Start_Placebo", "End_Placebo","End")) 1052 

env.treatment<-as.factor(meta_table$Treatment) 1053 

env.treatment #check the levels of treatment 1054 

env.patient<-as.factor(meta_table$Patient) 1055 

env.patient #check the levels of patient 1056 

 1057 

#Calculate Bray-Curtis dissimilarity values 1058 

BC_OTU_table <- vegdist(abund_table, method="bray", binary = FALSE) 1059 

mat_BC <- data.matrix(BC_OTU_table) 1060 

 1061 

#NMDS ordination of Bray-Curtis dissimilarity values  1062 

sol<-metaMDS(abund_table,distance = "bray", k = 2, trymax = 50) 1063 

 1064 

#Plot NMDS with ellipses around treatment groups and add in genus names (top 7% 1065 

genera) 1066 

win.graph()  1067 

plot(sol, display="sites", type="n", main="Treatment") 1068 

points(sol, cex=1, pch=19, col=env.treatment) 1069 

ordiellipse(sol, group=env.treatment, show.groups = "Screening", 1070 

col="black", kind="sd", lwd=2) 1071 

ordiellipse(sol, group=env.treatment, show.groups = "Start_OligoG", col= 1072 

"red" , kind="sd", lwd=2) 1073 



ordiellipse(sol, group=env.treatment, show.groups = "End_OligoG", col=  1074 

"green3" , kind="sd", lwd=2) 1075 

ordiellipse(sol, group=env.treatment, show.groups = "Start_Placebo", col= 1076 

"blue" , kind="sd", lwd=2) 1077 

ordiellipse(sol, group=env.treatment, show.groups = "End_Placebo", col=  1078 

"cyan" , kind="sd", lwd=2) 1079 

ordiellipse(sol, group=env.treatment, show.groups = "End", col= "magenta" , 1080 

kind="sd", lwd=2) 1081 

legend("topright", c("Screening", "Start_OligoG", 1082 

"End_OligoG","Start_Placebo", "End_Placebo","End"), cex=0.7, col=c 1083 

("black","red","green3","blue","cyan","magenta"), lwd=2) 1084 

top_7_pc<-ordiselect(abund_table, sol, ablim = 0.07, choices = c(1, 2), 1085 

method = "axes", freq = FALSE) 1086 

ordipointlabel(sol, display="species", select = top_7_pc, col="black", 1087 

cex=1, add = TRUE) 1088 

 1089 

#Plot NMDS with ellipses around patient groups 1090 

win.graph() 1091 

env.patient 1092 

plot(sol, display="sites", type="n", main="Patient") 1093 

points(sol, cex=1, pch=19, col=env.patient) 1094 

ordiellipse(sol, group=env.patient, show.groups = "27610001", col="red", 1095 

kind="sd", lwd=2) 1096 

ordiellipse(sol, group=env.patient, show.groups = "27610002", col= 1097 

"#FF7600" , kind="sd", lwd=2) 1098 

ordiellipse(sol, group=env.patient, show.groups = "27610003", col=  1099 

"#FFEB00" , kind="sd", lwd=2) 1100 

ordiellipse(sol, group=env.patient, show.groups = "27610004", col= 1101 

"#9DFF00" , kind="sd", lwd=2) 1102 

ordiellipse(sol, group=env.patient, show.groups = "27610005", col=  1103 

"#27FF00" , kind="sd", lwd=2) 1104 

ordiellipse(sol, group=env.patient, show.groups = "27610006", col= 1105 

"#00FF4E" , kind="sd", lwd=2) 1106 

ordiellipse(sol, group=env.patient, show.groups = "27610007", col=  1107 

"#00FFC4" , kind="sd", lwd=2) 1108 

ordiellipse(sol, group=env.patient, show.groups = "27610008", col= 1109 

"#00C4FF" , kind="sd", lwd=2) 1110 

ordiellipse(sol, group=env.patient, show.groups = "27610009", 1111 

col="#004EFF", kind="sd", lwd=2) 1112 

ordiellipse(sol, group=env.patient, show.groups = "27610011", col= 1113 

"#2700FF" , kind="sd", lwd=2) 1114 



ordiellipse(sol, group=env.patient, show.groups = "27611002", col=  1115 

"#9D00FF" , kind="sd", lwd=2) 1116 

ordiellipse(sol, group=env.patient, show.groups = "27611005", col= 1117 

"#FF00EB" , kind="sd", lwd=2) 1118 

ordiellipse(sol, group=env.patient, show.groups = "27611006", col=  1119 

"#FF0076" , kind="sd", lwd=2)  1120 

 1121 

#Permanova using adonis to determine whether groups are significantly different. 1122 

Adonis cannot handle random effects (Patient) but can structure the formula ~ A + B to 1123 

calculate the amount of variation explained by A (Patient) and then B (Treatment). This 1124 

is not ideal as permanova can only really handle fixed effects, but the best that can be 1125 

done this way. 1126 

adonis(mat_BC ~ Patient + Treatment, data =meta_table, permutations = 999) 1127 

 1128 

#Check beta dispersion. Groups should have the same variance to satisfy the 1129 

conditions of permanova. 1130 

beta <- betadisper(BC_OTU_table, meta_table$Treatment) 1131 

permutest(beta) #not significant so datasets should have same variance 1132 

beta2 <- betadisper(BC_OTU_table, meta_table$Patient) 1133 

permutest(beta2)#not significant so datasets should have same variance 1134 

 1135 

5) Statistical analysis of paired samples from different treatment groups 1136 

#Subset the data into separate datasheets for combined (e.g. Start + End) and 1137 

individual (e.g. Start) treatments 1138 

subsetScreen_End<-subset(meta_table, Treatment=="Screening"| 1139 

Treatment=="End") 1140 

subsetOligoGstart_end<-subset(meta_table, Treatment=="Start_OligoG"| 1141 

Treatment=="End_OligoG") 1142 

subsetPlacebostart_end<-subset(meta_table, Treatment=="Start_Placebo"| 1143 

Treatment=="End_Placebo") 1144 

 1145 

subsetScreen<-subset(meta_table, Treatment=="Screening") 1146 

subsetEnd<-subset(meta_table, Treatment=="End") 1147 

subsetStartOligoG<-subset(meta_table, Treatment=="Start_OligoG") 1148 

subsetEndOligoG<-subset(meta_table, Treatment=="End_OligoG") 1149 

subsetStartPlacebo<-subset(meta_table, Treatment=="Start_Placebo") 1150 

subsetEndPlacebo<-subset(meta_table, Treatment=="End_Placebo") 1151 

 1152 

#Statistical analysis of differences in Shannon diversity/total abundance by qPCR 1153 

between treatment groups using Wilcoxon signed-rank tests (example given for Screen 1154 



- End group and Shannon diversity, but same process applies to other treatment group 1155 

comparisons and qPCR data) 1156 

#Check normality (shapiro.wilk), the spread of the data (boxplots) and homogeneity of 1157 

variances (bartlett,test and leveneTest) 1158 

by (subsetScreen_End$shannon.diversity, subsetScreen_End$Treatment,  1159 

shapiro.test)  1160 

boxplot(subsetScreen_End$shannon.diversity~subsetScreen_End$Treatment) 1161 

bartlett.test(subsetScreen_End$shannon.diversity~subsetScreen_End$Treatment1162 

) 1163 

leveneTest(subsetScreen_End$shannon.diversity~subsetScreen_End$Treatment)  1164 

 1165 

#Further investigation of each treatment group individually for normality (histogram 1166 

of data distribution and qqplot) 1167 

hist(subsetScreen$shannon.diversity) 1168 

qqnorm(subsetScreen$shannon.diversity) 1169 

qqline(subsetScreen$shannon.diversity)  1170 

 1171 

#In this case data were normal with homogeneous variances so used a Wilcoxon 1172 

signed-rank test 1173 

wilcox.test(subsetScreen$shannon.diversity, subsetEnd$shannon.diversity, 1174 
paired = T) 1175 

 1176 

#Statistical analysis of differences in relative abundance of a key pathogen between 1177 

treatment groups using GAMLSS-BEINF and (mu) logit links (example given for Screen 1178 

- End group). 1179 

#Check the distribution of the data, here the data follows a zero-one inflated beta 1180 

distribution for both treatment groups being compared 1181 

hist(subsetScreen$Burkholderia) 1182 

hist(subsetEnd$Burkholderia) 1183 

 1184 

#Perform the GAMLSS-BEINF analysis 1185 

subsetScreen_End$Burkholderia_proportion<-subsetScreen_End$Burkholderia/100 1186 

#make proportion and append column to dataset 1187 

subsetScreen_End$Patient<-as.factor(subsetScreen_End$Patient) 1188 

modBcc <- gamlss(Burkholderia_proportion ~ Treatment + random(Patient),  1189 

family = BEINF, data = subsetScreen_End)  1190 



summary(modBcc) 1191 

 1192 

#Plotting the results of all the comparisons as boxplots. There are three pairs of 1193 

treatment comparisons (Screen – End, OligoG Start – OligoG End and Placebo Start – 1194 

Placebo End) for three response variables (Shannon diversity, qPCR total abundance 1195 

and relative abundance) giving nine plots. 1196 

#Plotting the nine plots individually 1197 

win.graph() 1198 

plot1<-ggplot(subsetScreen_End, aes(x = Treatment, y = shannon.diversity, 1199 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1200 

= "Set1") + theme(legend.position = "none") + 1201 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1202 

ylim (0,2.5) 1203 

plot2<-ggplot(subsetOligoGstart_end, aes(x = Treatment, y = 1204 

shannon.diversity, fill=Treatment)) + geom_boxplot() + theme_bw() + 1205 

scale_fill_brewer(palette = "Set1") + theme(legend.position = "none") + 1206 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1207 

ylim (0,2.5) 1208 

plot3<-ggplot(subsetPlacebostart_end, aes(x = Treatment, y = 1209 

shannon.diversity, fill=Treatment)) + geom_boxplot() + theme_bw() + 1210 

scale_fill_brewer(palette = "Set1") + theme(legend.position = "none") + 1211 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1212 

ylim (0,2.5) 1213 

plot4<-ggplot(subsetScreen_End, aes(x = Treatment, y = qPCR, 1214 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1215 

= "Set1") + theme(legend.position = "none") + 1216 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1217 

ylim (0,9) 1218 

plot5<-ggplot(subsetOligoGstart_end, aes(x = Treatment, y = qPCR, 1219 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1220 

= "Set1") + theme(legend.position = "none") + 1221 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1222 

ylim (0,9) 1223 

plot6<-ggplot(subsetPlacebostart_end, aes(x = Treatment, y = qPCR, 1224 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1225 

= "Set1") + theme(legend.position = "none") + 1226 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1227 

ylim (0,9) 1228 

plot7<-ggplot(subsetScreen_End, aes(x = Treatment, y = Burkholderia, 1229 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1230 



= "Set1") + theme(legend.position = "none") + 1231 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1232 

ylim (0,100) 1233 

plot8<-ggplot(subsetOligoGstart_end, aes(x = Treatment, y = Burkholderia, 1234 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1235 

= "Set1") + theme(legend.position = "none") + 1236 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1237 

ylim (0,100) 1238 

plot9<-ggplot(subsetPlacebostart_end, aes(x = Treatment, y = Burkholderia, 1239 

fill=Treatment)) + geom_boxplot() + theme_bw() + scale_fill_brewer(palette 1240 

= "Set1") + theme(legend.position = "none") + 1241 

theme(axis.title.x=element_blank()) + theme(axis.title.y=element_blank()) + 1242 

ylim (0,100) 1243 

 1244 

#Combining all nine plots into one plot 1245 

plot_grid(plot1, plot2, plot3, plot4, plot5, plot6, plot7, plot8, plot9, 1246 

nrow = 3, align = "h") 1247 

 1248 

 1249 

6) Linear regression FEV1 and Shannon diversity 1250 

#In the Bcc trial ‘End’ samples did not have associated FEV1 data, subset the data to 1251 

include all time points except ‘End’. 1252 

subsetFEV1_data<-subset(meta_table, Treatment=="Screening"| 1253 

Treatment=="Start_OligoG"| Treatment=="End_OligoG"| 1254 

Treatment=="Start_Placebo"| Treatment=="End_Placebo") 1255 

 1256 

#Plot the two variables FEV1%predicted and Shannon diversity and perform linear 1257 

regression to plot a trend line. This steps allows visualisation of the data and 1258 

identification of potential correlations. 1259 

linearmod<-lm(subsetFEV1_data$shannon.diversity~ 1260 
subsetFEV1_data$FEV1_percent_predicted) 1261 

print(linearmod) 1262 

summary(linearmod) 1263 

plot(subsetFEV1_data $FEV1_percent_predicted, 1264 
subsetFEV1_data$shannon.diversity, pch=16, col="black", main="Bcc FEV1 vs. 1265 
diversity") 1266 

abline(lm(subsetFEV1_data$shannon.diversity~ 1267 
subsetFEV1_data$FEV1_percent_predicted)) 1268 

 1269 



#Patient needs to be taken into account as a random effect to determine statistical 1270 

significance. Use a mixed model to do this (nlme package). 1271 

 1272 

mixedlm<-lme(shannon.diversity~FEV1_percent_predicted, random = ~1|Patient, 1273 

data=subsetFEV1_data) 1274 

summary(mixedlm)  1275 

 1276 

#Check residuals of model, residuals need to be evenly distributed around 0 and to fall 1277 

along the line in a qqplot. 1278 

plot(mixedlm) 1279 

qqnorm(resid(mixedlm)) 1280 

qqline(resid(mixedlm)) 1281 

 1282 

7) Analysis of V1 samples: hierarchical clustering 1283 

#For V1 Screening samples hierarchical clustering was performed for the Bcc trial and 1284 

the P. aeruginosa trial. NMDS ordination of Bray-Curtis dissimilarity values and 1285 

boxplots of qPCR total abundance values were also used to investigate the data for the 1286 

Bcc trial. As the R scripts for NMDS and plotting boxplots have been described 1287 

previously they will not be shown again. Here hierarchical clustering of the Bcc V1 data 1288 

is shown. 1289 

#Read in OTU tables and metadata spreadsheets, the OTU table and metadata 1290 

spreadsheets used previously need to be modified to remove all samples except those 1291 

at screening (V1). This can be done in excel and the files read into R as before. 1292 

data_V1<-read.table(file.choose(), header=T) 1293 

meta_table_V1<-read.csv(file.choose(),row.names=1,check.names=FALSE) 1294 

 1295 

#Format the OTU table to find the relative abundance of each genus in each sample. 1296 

OTU_total<-cbind(data_V1, total = rowSums(OTU_table_to_format)) 1297 

OTU_order<-OTU_total[order(-OTU_total$total),] 1298 

OTU_order_no_total<-subset(OTU_order, select = -c(total)) 1299 

OTU_order_no_total_matrix<-as.matrix(OTU_order_no_total) 1300 

transposed_matrix<-t(OTU_order_no_total_matrix) 1301 

OTU_relabund<-make_relative(transposed_matrix) 1302 

transposed_relabund<-t(OTU_relabund)  1303 

percent_relabund<-(transposed_relabund)*100 1304 

 1305 



#Indicate which column annotations you need for the heatmap. Here the Burkholderia 1306 

species is the column annotation (in the column ‘Species’ of the metadata file) 1307 

env.species<-as.factor(meta_table_V1$Species) 1308 

env.species 1309 

 1310 

#Choose the colour palette for the heatmap. The first command opens a colour palette 1311 

so you can choose the colour scale, the second command reverses the colours in the 1312 

palette (light-dark or dark-light) 1313 

mypalette<-choose_palette() 1314 

col_rev <- rev(mypalette(25)) 1315 

 1316 

#Draw the heatmap. These commands specify to only include the top 15 rows by 1317 

highest OTU abundance. Hierarchical clustering is performed using Bray-Curtis 1318 

dissimilarity values and Ward’s clustering algorithm. 1319 

win.graph() 1320 

Top15_rownames<-rownames(percent_relabund[1:15,]) 1321 

heatmap_Bcc_V1=aheatmap(percent_relabund, distfun = function(x) vegdist(x, 1322 
method = "bray"), hclustfun = function(x) hclust(x, method = "ward.D2"), 1323 
color = col_rev, treeheight = 30, Rowv=NA, annCol = env.species, annColors 1324 
= list(c("B. cenocepacia" ="#b2df8a", "B. multivorans"="#fdbf6f","No Bcc 1325 
detected"="#fb9a99")), subsetRow =  Top15_rownames)                1326 

heatmap_Bcc_V1 1327 

 1328 

8) Pearson product-moment correlation coefficient (PPMCC) using the pearson 1329 

correlation to compare bacterial community composition between paired 1330 

samples 1331 

 1332 

#OTU table: Compile an excel spreadsheet for each patient with genus/OTU as column 1333 

1 without a heading. All the other columns have sample number as a heading and read 1334 

numbers in rows corresponding to the genus/OTU in column 1. Save as a .txt file and 1335 

read into R. An example for one patient is given below. 1336 

 1337 

Patient1<-read.table(file.choose(), header=T, check.names="FALSE") 1338 

 1339 

#Perform a correlation test for all of the different combinations of paired samples for 1340 

each patient. An example for one patient is given below. 1341 



 1342 

cor.test(Patient1$V1_1, Patient1$V1_2, method = "pearson") 1343 

cor.test(Patient1$V2_1, Patient1$V2_2, method = "pearson") 1344 

cor.test(Patient1$V4_1, Patient1$V4_2, method = "pearson") 1345 

cor.test(Patient1$V5_1, Patient1$V5_2, method = "pearson") 1346 

cor.test(Patient1$V7_1, Patient1$V7_2, method = "pearson") 1347 

cor.test(Patient1$V8_1, Patient1$V8_2, method = "pearson") 1348 

 1349 

#These values can be collated to determine key statistics such as mean and median, 1350 

and the spread of the data visualised using boxplots 1351 

 1352 

 1353 

 1354 

 1355 


